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1 How to use this user manual 

1.1 Symbols and signal words 

Please be sure that you understand the meanings of the symbols and signal words described 

below before you move on. 

 

DANGER 

… indicates an imminently hazardous situation which, if not avoided, will result in death or 

serious injury.1 

 

WARNING 

… indicates a potentially hazardous situation which, if not avoided, could result in death or 

serious injury.2 

 

 

 

1 Serious injury includes blindness, wounds, burns (low and high temperature), electric shock, fractures, 

and poisoning, etc. which have long-lasting consequences or require hospitalization and/or long-term 

treatment. 
2 Serious injury includes blindness, wounds, burns (low and high temperature), electric shock, fractures, 

and poisoning, etc. which have long-lasting consequences or require hospitalization and/or long-term 

treatment. 
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CAUTION 

… indicates a potentially hazardous situation which, if not avoided, could result in minor or 

moderate injury.3 

 

NOTICE 

… indicates a potentially hazardous situation which, if not avoided, could result in property 

damage and other problems, but not personal injury. 

 

IMPORTANT 

… indicates an important information. 

 

TIP 

… indicates a practice that facilitates work. 

Procedure 

… indicates a call to action. After this signal word you must execute one or more steps. We 

made an exception for DANGER-, WARNING-, CAUTION-, and NOTICE-boxes where we 

omitted this signal word as avoidance procedures are mandatory there. 

1.2 Notation conventions 

This user manual uses the following notation conventions. 

 

 

3 Minor or moderate injury includes wounds, burns, electric shock, etc. not requiring hospitalization 

and/or long-term treatment. 
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Notation Meaning 

Underlined click-able cross reference or hyperlink 

Bold element in the graphical user interface that the user shall click 

Italic name of element in the graphical user interface or emphasized text 

Typewriter text that the user must type in, filename, or path 

1.3 Storage and replacement 

• Keep this user manual with the product to access it at any time during its lifetime. 

• Be mindful of the environment, do not print this user manual unless necessary. 

• This user manual is part of the product. If ownership changes, then this user manual 

must accompany the product. 

• You can access the latest copy of this manual on our website: 

https://novantaphotonics.com/  

1.4 Specifics and structure 

Novanta reserves the right to make changes to the product covered in this user manual to 

improve its performance, reliability, or manufacturability. Contents of this user manual are 

subject to change without notice. 

Although every effort has been made to ensure the accuracy of the information contained in 

this user manual, Novanta assumes no responsibility for inadvertent errors. 

This user manual covers the system requirements and overview of the product, and 

instructions for use. 

https://novantaphotonics.com/
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1.5 Purpose 

The aim of this manual is to provide a brief description of the ScanMaster™ Designer 

software and its functions. This document will mainly focus on the 3D laser marking 

processes and the capabilities of ScanMaster™ Designer software to do surface marking and 

engraving processes. Furthermore, this document will guide you through a three-step 

process to achieve the final 3D laser marking. You will learn the options to create a 3D model, 

modify as desired and then to perform the process. The features of this application will be 

demonstrated using simple scenarios which will be helpful for you to understand the process 

more effectively. You will also find some main points that you should remember when 

managing a 3D laser marking project in ScanMaster™ Designer software. 

TIP 

To understand this application and its features perfectly you are required to have a general 

knowledge about the ScanMaster™ Designer 2D application. 

1.6 Target audience and qualification 

IMPORTANT 

Only target audience, who are listed in the beginning of each instructing section in the 

following chapters, may perform the activities described there. 

 

The people who perform these activities need to be of age. 

The qualification of the target audience is defined below. 

Laypersons 

without special qualification, who e.g., transport and store the boxed product. 

Operators 

who are trained by the company that is operating the laser unit that contains the 

product, in the use of that laser unit and who confirmed the training by signature. 
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Experts 

in electrical engineering or mechatronics with successful training in handling highly 

sensitive electronic and optical equipment. Experts must be trained by the company 

that is operating the laser unit that contains the product in the use of that laser unit. 

Administrators 

with full access to the computer’s hardware and software. 

1.7 Revision history 

Table 1 – Revision history 

Revision Date Changes from previous revision 

A October 1, 2014 First publication of this manual per ECO 8250 

B June 26, 2015 Increased permissible cooling air pressure to 2 PSIG per 

ECO 8639. 

C August 8, 2016 Corrected error in Figure 44 and added note on cooling 

water (pg. 44) 

D March 2024 Updated to new Template 
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2 General safety instruction 

This chapter lists important precautions which users of the product (and anyone else) must 

observe to avoid injury and damage to property, and to ensure safe and correct use of the 

product. 

2.1 Disambiguation of term ‘laser unit’ 

A laser unit is a machine that incorporates a laser device (that is the actual laser), the product 

and other components. 

2.2 Intended use 

The product is delivered as an OEM component for integration into a laser unit that uses a 

class 4 laser. 

• Before installing and operating the product, carefully read this user manual for your 

protection. 

• Retain this user manual for future reference. 
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IMPORTANT 

Novanta has no influence over the employed laser device or the overall laser unit. 

• Customers assume full responsibility for implementing and maintaining a laser-safe 

working environment.  

• Original equipment manufacturer (OEM) customers assume full responsibility for CDRH 

(Center for Devices and Radiological Health) certification and compliance with the 

standards and guidelines required for the CE (European Conformity) label. 

• Please contact Novanta for further information about the product and applicable 

guidelines. 

2.3 Reasonably foreseeable misuse 

It is considered a misuse if you use the product without incorporating it into a laser unit that 

complies with the standards and guidelines required for the CE (European Conformity) label. 

2.4 Radiation hazards 

The product is designed to be operated in conjunction with a class 4 laser. 

WARNING 

Laser radiation can cause severe retinal and corneal burns, burns on the skin, and may pose 

a fire risk. 

• To avoid injury and reduce risk of fire, please follow the control measures and safety 

guidelines provided by the laser’s manufacturer, and those established by your Laser 

Safety Officer (LSO), Radiation Safety Officer (RSO), or safety department of your 

business or institution. 
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NOTICE 

Exceeding power handling limits of mirrors and lenses may damage the scanning system. 

The power handling limits of mirrors and lenses can vary depending on laser parameters such 

as beam size, laser power, pulse duration, and pulse energy. 

• Ensure that the laser parameters are appropriate for the exact scanning system that is 

in use. 

The standard warranty does not cover damage caused by laser power settings that 

are above the maximum limits for each optic.  

• Please contact Novanta if you are not sure about the power limitations of your 

scanning system. 

 

NOTICE 

Back-reflections of laser radiation may damage the scanning system. Any flat or curved 

surface (including protective windows) between scanning mirrors and the work field will have 

back-reflections where some percentage of the beam propagating toward the work field will 

reflect from this surface and will travel back towards the scanning system. Although, the 

absolute laser power of the backwards propagating beam may be low, the beam may come 

to a focus on or close to a scanning system optic and the laser damage may occur due to the 

power density of the laser beam. 

• Make sure that any back-reflections from any surface downstream of the scanning 

system is managed properly. 
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2.5 System safety 

WARNING 

Use of controls, adjustments, or procedures other than those specified in this manual 

may result in component damage, and/or exposure to potential hazards.  

• Always follow established industrial safety practices when operating equipment and 

consulting a competent safety professional. 

 

NOTICE 

Errors can cause system damage. 

• Always check your application program before running it. 

2.6 Modifications 

Modifications to the product are not permitted. 
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3 Overview 

3.1 What is laser marking? 

3D laser marking refers to the laser marking performed on a 3D workspace. 3D laser marking 

comprises a range of 3D related processes including all types of Surface Markings, Engraving, 

Sub Layer Laser Engraving and Prototyping. 3D laser marking technology is widely used by 

many industries such as packaging, automobile manufacturing, jewelry etc. 

ScanMaster™ Designer software allows you to create a digital 3D model and apply 2D images 

to a 3D surface. This application facilitates 3D marking with either projection or wrapping 

styles. 

This application also enables you to do laser engravings by specifying different sections and 

layers. More detailed information about these features will be discussed in this document. 

The marking procedure can be customized using the ScanScript language in which you can 

experience the advanced capabilities not available through the user interface. 

TIP 

A detailed description about projection and wrapping styles and their differences will be 

discussed in section 11.1 Surface Marking on page 112. 

3.2 Scan controller cards 

There are 2 different scan controller cards available which are supported by ScanMaster™ 

Designer software: 
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• ScanMaster Controller (SMC) 

The SMC is a self-contained controller that provides advanced hardware and software 

control technology to drive laser scanning systems. The Ethernet connected SMC 

board is designed to permit remote embedding and control of a scan-head and laser 

system. It can control 2 scan-heads with up to 3 motion axes each with concurrent 

laser timing control. It also provides integrated synchronization I/O for connection to 

factory automation equipment. 

• EC1000  

The EC1000 is a self-contained controller that provides advanced hardware and 

software control technology to drive laser scanning systems. The EC1000 control 

board is specifically designed for remote embedding and control of a scan-head and 

laser system. It can control 2 scan-heads with up to 3 motion axes each with 

concurrent laser timing control. It also provides integrated synchronization I/O for 

connection to factory automation equipment. The EC1000 controller card is the core 

of the SM1000 Controller Module. 
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4 Getting started 

Use information in this section to install and start the ScanMaster™ Designer software. This 

section will also introduce the key features of the program as well as recommended tips for 

establishing a good workflow. 

4.1 System requirements 

The following software and hardware specifications are the minimum system requirements to 

install and run ScanMaster™ Designer software on your computer: 

• Processor: 1 GHz 

• Memory: 1 GB 

• Hard disk space: 1 GB 

• Display: 1024 × 768 high color (16-bit) 

• Operating system:  

Windows XP Professional SP3 / Windows Vista SP2 / Windows 7 SP1 

4.2 Starting/exiting ScanMaster™ Designer 

To start ScanMaster™ Designer 

1. On the taskbar, click Start. 

2. Select Programs and locate the CTI folder and then the ScanMaster™ Designer sub-

folder. 
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3. Click the ScanMaster™ Designer  icon. 

The following window will appear: 

 

Figure 1 – Start-up screen 

4. To start a new project, click New on the Home tab. 

A basic marking job is created by placing different basic shapes such as a box, sphere, 

cone, or a cylinder on the canvas. Each 3D shape has its own unique properties which 

can be modified. See chapter 7 on page 46 ff, for detail information about creating 

projects. 

To exit ScanMaster™ Designer 

• Close the ScanMaster Designer window or select Exit from the ScanMaster™ Designer 

button. 

 



4 Getting started  4.3 Workspace elements 

ScanMaster Designer 3D Extensions, User Manual, 1040-0009 Rev D 25 

4.3 Workspace elements 

Before you can begin using the software you need to be familiar with the ScanMaster™ 

Designer user interface. Let’s start by looking at the main application window and how it’s 

laid out. 

 

Figure 2 – Workspace elements 

4.4 Recommended workflow 

The figure below shows the recommended workflow for ScanMaster™ Designer projects. 
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Figure 3 – Recommended workflow 

1. Create a 3D Model. 

A “Job” is a simple program that contains Models, Processes and Scripts that are 

executed in the prescribed order. You might want to create a job to make a Surface 

Marking process or an Engraving process. The options in ScanMaster™ Designer 

software, allows you to do these tasks easily. 

Insert basic shapes to the drawing canvas by selecting any desired basic 3D shape 

from the Primitives group of the Modeling tab. You can insert many shapes to create 

one 3D model. 

TIP 

Refer to chapter 8 on page 51 ff to check detailed information on creating 3D models 

in a 3D project. 

 

2. Edit the 3D Model. 

After you have inserted shapes, you can edit them as preferred. ScanMaster™ 

Designer software is equipped with a rich collection of editing tools which you can 

use to edit your 3D models. The options in the Modeling tab of the Ribbon will enable 

you to modify the 3D shapes according to your requirements. 

TIP 

Refer to chapter 9 on page 58 ff to check detailed information on how to modify 3D 

models. 
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3. Prepare the 3D Process. 

To prepare a 3D model to be processed on the laser marking, the commands in the 

Engraving tab and Surface Marking will enable you to set the specifications thereby 

preparing the model to be processed to achieve the output according to your 

requirements. 

TIP 

Refer to chapter 10 on page 82 ff to check detailed information on preparing the 3D 

model to be processed. 
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5 ScanMaster Designer interface – The 

Ribbon 

Across the top of the window is the Ribbon. All the application’s functions can be accessed 

from here and it’s the first place you should look if you’re new to the software and want to 

get an idea of what you can do with it. As your mouse passes over the menu, tool tips will be 

displayed. 

The Ribbon provides easy access to the ScanMaster™ Designer tools that can be used to 

create and edit 3D models. Tools are logically grouped into a collection of Tabs. Each tab 

contains multiple Groups, and each group contains a set of related commands. The Ribbon is 

docked on top of the ScanMaster™ Designer drawing canvas. 

Each item is described in further detail in the following sections. 

5.1 Home 

The Home tab on the Ribbon contains the Standard, Edit, View, and Mark groups. 

 

Figure 4 – Home tab 
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5.1.1 Standard 

The Standard group allows you to create new, open, save or import 3D and 2D files into the 

workspace. 

Table 2 – Home tab – Standard group 

Icon Command Description 

 
New  Opens a new project  

 
Open  Opens a saved project  

 
Save  Saves the current project  

 
Save As  Saves a new project or an existing project which is already 

opened, in a different name  

 
Export Disabled for 3D  

5.1.2 Edit 

The commands in this group are designed to help you to delete, undo or redo the changes 

you make to the shapes inserted into the models. 

Table 3 – Home tab – Edit group 

Icon Command  Description 

 
Paste Disabled for 3D 

 Cut Disabled for 3D 

 Copy Disabled for 3D 

 Delete Deletes all selected objects 

 Undo Reverse the last action performed. You may also undo the last few 

actions that were performed by clicking the arrow next to Undo 
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Icon Command  Description 

 Redo Re-apply the actions that you undid last 

5.1.3 View 

The options in this group enable you to view the drawing canvas in different ways according 

to your requirement. 

Table 4 – Home tab – View group 

Icon Command Description 

 
Zoom In Enlarges the display size of the workspace on the screen 

 
Zoom Out  Reduce the display size of the workspace on the screen  

 
Fit to All  Adjust the zoom level to fit the entire contents of the drawing into 

the current view  

 
Zoom 

Window  

Zoom Window offers a quick way to zoom a certain area of the 

drawing canvas 

 
Pan  Panning allows you to quickly move around the canvas at the 

same magnification you have currently set  

 
Show Field  Resets the drawing canvas to the default viewing configurations 

 Zoom Factor  The Zoom Factor allows you to zoom in or out by the specified 

zoom factor  

 
Rotate  Rotates the drawing canvas  
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5.1.4 Mark 

Table 5 – Home tab – Mark group 

Icon Command  Description 

 
Start Start marking 

 Pause Pause marking 

 Stop Stop marking 

 Trace Trace the outer line of the drawing 

 Align Trace the bounding box of the current job 

 
Download Download scanning jobs to a flash memory in the card or to a 

USB memory 

 Scan Project Scans the whole project including execution of the script 

5.2 Project 

 

Figure 5 – Project tab 
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5.2.1 Basic Elements 

Add new elements to the project. 

Table 6 – Project tab – Basic Elements group 

Icon Command Description 

 
2D Image Add new 2D Image to the project 

 
3D Model  Add new 3D model to the project 

 
Script Add new script to the project 

 
Import Allows you to import 2D image, 3D model or script from file 

5.2.2 Marking Process 

The Marking Process group gives you the options of the start of the 3D marking processes. 

Table 7 – Project tab – Marking Process group 

Icon Command Description 

 
Surface 

Marking  

Creates a new surface marking process on the project  

 
Engraving Creates a new engraving process on the project 

5.3 Modeling 

The Modeling tab on the Ribbon enables you with many attractive options to modify the 3D 

shapes to create complex 3D models easily 
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Figure 6 – Modeling tab 

5.3.1 Primitives 

The Primitives group displays, the four basic 3D shapes to insert into the workspace which 

then you can modify them using the other options in the Modeling tab. 

Table 8 – Modelling Tab – Primitives group 

5.3.2 Transformations 

The Transformations group guides you on transforming the 3D shapes as required. 

Table 9 – Modelling tab – Transformations group 

Icon Command Description 

 
Box Inserts a three-dimensional cuboid on the drawing canvas 

according to the given width, height, and length. 

 
Cylinder  Creates a cylindrical shape according to the given radius and 

height. 

 
Cone  Inserts a cone shape according to the specified base and top 

radius and the height. 

 
Sphere Inserts a sphere on the drawing canvas according to the defined 

radius 

Icon Command Description 

 
Rotate Rotates a shape around a specified axis on the canvas 
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5.3.3 Solid Operations 

The Solid Operations group allows you to modify the 3D shapes in different ways. 

Table 10 – Modelling tab – Solid Operations group 

Icon Command Description 

 
Scale  Changes the size of any object drawn or loaded to the canvas 

 
Mirror Creates a symmetrical mirror image of the selected shape according 

to the specified mirror axis 

 
Move  Moves a shape to a new position you specify related to the current 

position 

 
Move to 

Origin  

Moves the selected shape(s) to the origin of the canvas 

 
Aligning Aligns two or more objects’ bounding boxes to any of the given 

alignments  

 
Face Oriented 

Alignment 

Changes the alignment of a selected face so that it is oriented 

perpendicular to the given axis 

Icon Command Description 

 
Face Revolve Revolves the selected face of the object according to a specified x, y 

or z axis or arbitrary axis values.  

 
Face 

Extrusion  

Changes the dimension of an object by extending a selected face 

according to a specified extrusion length.    

 
Fillet Curves the shape of the selected mode, by a given radius 

 
Selection 

Mode 

Selects the 3D shapes by faces, edges, vertices or neutral.  
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5.3.4 Boolean Operations 

This group allows you to modify two selected 3D shapes in terms of Cut, Fuse and Common. 

Table 11 – Modelling tab – Boolean Operations group 

5.4 Engraving 

The Engraving tab on the Ribbon provides you the capability to adjust the 3D model for 

engraving. 

 

Figure 7 – Engraving tab 

5.4.1 View 

The options in this group enable you to view engraved objects in different views. 

Icon Command Description 

 
Lighting  Changes the lighting effects from different directions.  

Icon Command Description 

 
Cut This command gives you the option of cutting a particular 

overlapped section of the first selected 3D shape  

 
Fuse  The fuse command allows you to join two or more 3D objects 

together to make one 3D shapes 

 
Common Extracts the common section of two selected 3D shapes   
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Table 12 – Engraving tab – View group 

5.4.2 Engraving Simulation 

The options in this group allow you to preview specified sections of your engraving process. 

Table 13 – Engraving tab – Engraving Simulation group 

5.5 SurfaceMarking 

The SurfaceMarking tab on the Ribbon provides the capability to adjust the 3D model for 

surface marking. 

 

Figure 8 – SurfaceMarking tab 

Icon Command Description 

 
Boundary 

Only   

Allows you to view only boundary of the engraving object 

 
Hatch Only  Allows you to view only the hatch of the engraving object 

 
Boundary and 

Hatch   

Allows you to view both the boundary and hatch of the engraving 

object.   

Icon Command Description 

 
Start   Starts the preview of the engraving process 

 
Stop  Stops the preview of the engraving process 



5 ScanMaster Designer interface – The Ribbon  5.5 SurfaceMarking 

ScanMaster Designer 3D Extensions, User Manual, 1040-0009 Rev D 37 

5.5.1 View 

The options in the View group, provides different ways to visualize the 3D model. 

Table 14 – SurfaceMarking tab – View group 

5.5.2 Surface Marking 

Table 15 – SurfaceMarking tab – Surface Marking group 

 

 

Icon Command Description 

 
Shape and 

Mapped 

image   

Displays the 3D model and the mapped image 

 
Bounding Box 

and Shape  

Displays the 3D model and the bounding box of the mapped image 

 
3D Image 

only  

Displays only the mapped image  

Icon Command Description 

 
Add 2D 

Image  

This command allows you to add a 2D image to the canvas for 

processing 

 
Apply The Apply command allows you to apply the 2D image to your  3D 

model that you have created 
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6 Layout of 3D canvas 

6.1 Drawing canvas 

The 3D drawing canvas is the 3D workspace which allows users to see the graphical 

representation of a 3D model and work with it. 

 

Figure 9 – 3D drawing canvas 
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6.1.1 Grid type 

The Grid options are accessible by clicking on the Grid  button below the canvas. 

This command helps you to perfectly align shapes and drawings along the grid lines and 

points. 

The following images show the appearance of the different grid styles. 

 

Figure 10 – Blank grid 

 

Figure 11 – Line grid 

 

Figure 12 – Dotted grid 

6.1.2 View Orientation 

The View Orientation options are accessible by clicking on the View Orientation  button 

below the canvas. This command helps you to change the view of the drawing canvas in 

different directions. 
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Figure 13 – The viewing orientations 

TIP 

The objects in the canvas will be displayed in the Isometric view by default. 

6.1.3 Show Marking Volume 

The marking volume is indicated by a transparent pyramid shape. This represents the volume 

in which the scan head is capable of marking a given 3D point accurately. 

You can access the Marking Volume  button below the canvas. 

• Click on the Marking Volume button to show/hide the marking volume. 

The following images show the appearance with and without Marking Volume. 
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Figure 14 – Canvas with marking volume 

 

Figure 15 – Canvas without marking volume 

Any 3D models or sections of 3D models which are placed beyond the marking volume will 

not be marked by the scan head. 

6.1.4 Show Ruler 

• Click on the Ruler button below the canvas to show/hide the ruler. 

The following images show the appearance with and without the ruler. 
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Figure 16 – Canvas with ruler 

 

Figure 17 – Canvas without ruler 

A ruler is displayed along the X and Y axis of the drawing canvas to help you adjust the 

position of the 3D model in the drawing canvas. 

The position of the 3D model can be specified by defining the X and Y values in the 

Properties of the 3D model. 

6.1.5 Visual Styles 

The Shaded and Wire Frame options are accessible by clicking on the Visual Styles  

button below the canvas. 

 

Figure 18 – Visual styles 
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6.1.6 Trihedral 

The trihedral  at the bottom left corner of the canvas indicates X, Y and Z axes of the grid 

which complies with a right-handed Cartesian coordinate system. 

6.2 Project Explorer 

A project can have several 3D models and 2D images, marking processes and scripts. Any 2D 

image, 3D models, project or script created in the ScanMaster™ Designer software is visible 

on the Project Explorer tab, in a hierarchical structure. The current project is visible in the top 

level with corresponding 2D images, 3D models, processes, and the script files below it. 

To view the elements on the project explorer, click on the Project Explorer tab which is on 

the top-right corner of the application. 

 

Figure 19 – Project Explorer 

The following table describes the commands and icons displayed in the Project Explorer tab. 

Table 16 – Icons and commands in the Project Explorer tab 

Icon Command Description 
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6.3 Shape Tree 

The Shape Tree displays all the shapes inserted on the current model or process. To access 

the shape tree, click on the Shape Tree tab which is on the top-right corner of the 

application. 

Hide/Show/Rename/Delete 

The shape  can be hidden, shown using the / icons and rename or delete the shapes 

using the right-click options in the Shape Tree tab. 

1. Right-click on the shape from the Shape Tree. 

You will see the menu as shown in the figure below. 

Icon Command Description 

 Delete  This command deletes any selected element in the project explorer  

 Move Up This command will move the selected item one step up in the 

current list  

 Move Down This command  will move the selected item one step down in the 

current list 

  Project Settings  This command allows you to customize the project settings  
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Figure 20 – Shape Tree right-click menu 

2. Click the Rename command to change the default name of the selected shape of the 

shape tree. 

3. Click the Delete command to delete the selected shape from the project. 
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7 Managing projects 

A clear understanding of 3D project management in ScanMaster™ Designer will ensure an 

efficient workflow. This section guides you on certain basic areas which should be considered 

when managing a 3D project. 

7.1 Before you begin 

Before you create a new 3D project, you need to understand and focus on certain areas to 

gain optimal results: 

1. You should be familiar with the basics of ScanMaster™ Designer software interface. 

Refer to sections 4.2 Starting/exiting ScanMaster™ Designer on page 23 and 4.3 

Workspace elements on page 25 to have a clear idea about the application. 

2. Get familiar with the supportive 3D file formats, project structure and the project 

default settings. 

3. You can import 3D models from STEP, IGES and STL formats. 

4. Understand the concept of changing the measurement units of the projects. The 

measurement units of the 3D models that you insert into your canvas depend on the 

settings of the Default Units and Grid Spacing that you set in Project Settings 

therefore make sure that you have an idea about your measurement settings when 

you specify the parameters of any 3D models in your project. 
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TIP 

Please refer to chapter 5 Managing Projects in the ScanMaster™ Designer 2D – User 

Manual to check more facts that you should consider before you begin a 2D project in 

ScanMaster™ Designer 3D Extension. 

7.2 Preferences 

Preferences are the project default settings for any new project created in ScanMaster™ 

Designer software. They are organized as General, Editors, 2D Scanning and 3D Scanning tabs. 

The Preferences window is accessed by clicking the ScanMaster™ Designer  button on 

the upper-left corner of the screen. 

You will find the following Application Preferences window. 

 

Figure 21 – Application Preferences 
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7.2.1 Canvas 3D colors 

The Designer Colors (3D) tab allows adjustment of  the colors of the 3D workspace. As seen in 

the figure below, the application allows you to customize the colors of the objects in the 

drawing canvas, the rulers, ruler text, marking area, marking area lines, upper and lower 

backgrounds, grid lines and the surface marking logo. 

To change the color of an element 

1. Click the drop-down color chart button  and select the required color from 

either the preset colors or by means of the More Colors option, where you could 

specify RGB values to match a specific color. 

– OR – 

Click the Use Defaults button to reset the colors to their original state. 

2. Click on the OK button to save the changes you made to the colors of the layout and 

exit. 

3. Click Cancel if you want to exit without saving. 

7.2.2 Grid spacing 

You can display the Grid as a rectangular pattern of lines or dots. The spacing between the 

grid lines is called "Grid spacing". Grid spacing can be measured in either millimeters or 

inches. 

TIP 

Please refer to chapter 5 Managing Projects of the 2D User Manual for details on General, 2D 

Scanning and Editors > Designer Colors (2D) tabs. 

7.3 Creating a new project 

To create a new project 

• Choose New from the Home tab or press Ctrl + N. 
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A new drawing canvas will be opened. 

 

Figure 22 – Creating a new project 

Add 3D models to a project 

You may create several 3D models per project. 

1. Go to Project Ribbon tab. 

2. Click the 3D model   button on the Basic Elements group.  

A new 3D model will be added to the project, and it will be visible on the Project 

Explorer window as well. 
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TIP 

Refer to chapter 8 on page 51 ff to get more details on creating 3D models on your 3D 

project. 

Refer to chapter 5 Managing Projects of the 2D User Manual for details on opening and 

saving a project. 
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8 Creating 3D models 

The first step in the 3D model marking process is creating a 3D model. The ScanMaster™ 

Designer software allows you to create 3D models according to your requirements in 

different ways. You can create a 3D model from the beginning, or you can import an existing 

3D model to your project. 

8.1 Creating a blank 3D model 

To create a new 3D model of your own 

1. Go to Project Ribbon tab. 

2. Click the 3D model   button on the Basic Elements group. 

A new 3D model will be added to the project, and it will be visible on the Project 

Explorer window as well. 

A 3D model can be a collection of many 3D shapes. ScanMaster™ Designer software allows 

you to create any kind of 3D models using the basic 3D shapes provided to you. 

8.1.1 Inserting basic 3D shapes 

The ScanMaster™ Designer software comprises four basic 3D shapes including Box, Cylinder, 

Cone, and Sphere. You can access these shapes in the Primitives group of the Modeling tab. 

Each shape can be inserted on to the drawing canvas by specifying the relevant geometrical 

parameters. 
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8.1.2 Inserting a Box 

To insert a 3D box shape 

1. Click on the Box command in the Primitives group. 

The figure below shows the specifications of the parameters associated with the box 

shape and its output. 

 

Figure 23 – Insert Box 

 

The Base Point refers to the position of the Box on the drawing canvas. The base point 

is defined as the minimum X, Y and Z point of the box. 

The Width refers to the distance along the x axis. 

The Length refers to the distance along the y axis. 

The Height refers to the distance along the z axis. 

2. Click OK to confirm your specifications. 
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8.1.3 Inserting a Cylinder 

To insert a cylindrical shape 

1. Select the Cylinder command on the Primitives group of the Modeling tab. The 

figure below shows the specifications of the parameters associated with the Cylinder 

shape and its output. 

 

Figure 24 – Insert Cylinder 

 

The Center of Base Circle represented by the X, Y and Z coordinates refers to the 

center point of the base circle. 

The Radius refers to the radius of the base circle. 

The Height refers to the distance measured along the axis of the cylinder. 

2. Click OK to confirm your specifications. 

8.1.4 Inserting a Cone 

To insert a cone shape to the drawing canvas 

1. Select the Cone command from the Basic group. 

The figure below shows the specifications of the parameters associated with the Cone 

shape and its output. 
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Figure 25 – Insert Cone 

The Center of Base Circle represented by the X, Y and Z coordinates refers to the 

center point of the base circle. 

The Base Radius refers to the radius of the base circle. 

The Top Radius refers to the radius of the top circle. 

2. Click OK to confirm your specifications. 

8.1.5 Inserting a Sphere 

To insert a sphere shape on the drawing canvas 

1. Select the Sphere command from the Basic group. The figure below shows the 

specifications of the parameters associated with the Sphere and its output. 

 

Figure 26 – Insert Sphere 
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The Center represented by the X, Y and Z coordinates refers to the center point of the 

Sphere on the drawing canvas. 

The Radius refers to the radius of the Sphere. 

2. Click OK to confirm your specifications. 

TIP 

You can create complex 3D models by inserting many 3D shapes and modifying them to 

make one whole 3D model. Refer to chapter 9 on page 58 for more information on 

modifying 3D models. 

8.2 Create a 3D model from an existing file 

ScanMaster™ Designer software allows you to import existing 3D models to your project. 

 

Figure 27 – Select 3D File dialog 

 



8 Creating 3D models  8.3 Creating a 3D model using 2D shapes 

ScanMaster Designer 3D Extensions, User Manual, 1040-0009 Rev D 56 

1. Go to Project Ribbon tab. 

2. Select the 3D model  button from the import  drop down button. 

The 3D file dialog will be opened. 

3. Click Browse button to browse the existing 3D model file location. 

The Open dialog box will be displayed. 

4. Select the desired 3D model file and click Open. 

The location of the file will be identified and displayed in the File Path. 

The current width, height and length of  the 3D model will be identified automatically 

by the system. 

5. If you want to change the width, height, and length of the importing model, specify 

the values in the respective New Width, Height, and Length fields. 

6. Check the Move to Origin check box to move the importing 3D model to the origin 

of the canvas. 

7. Click OK. 

Supported files  

ScanMaster™ Designer software supports the following file formats to be imported to the 3D 

projects. 

• Standard for the Exchange of Product data (STEP) 

• Initial Graphics Exchange Specification (IGES) 

• STereo Lithography (STL) 

8.3 Creating a 3D model using 2D shapes 

The ScanMaster™ Designer supports 2D shape extrusion to create 3D shapes. Any simple or 

composite closed shape can be extruded in the Z axis direction to form a 3D shape by simply 

specifying the height of the expected 3D shape. 
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1. With a 3D model in place, select the desired 2D shape from the 2D canvas. 

2. Right-click on the selected shape and select Extrude from the pop-up menu. 

 

3. Specify the desired height for the extruded 3D shape. 

4. Select the 3D model from the drop-down list, onto which this extruded shape adds. 

You may use the multiple shape selection facility of the canvas either by drawing a selection 

box using the mouse or by selecting the required shapes while pressing the SHIFT button. 

Right click anywhere on the selected shapes to access the extrude menu. 

TIP 

Only closed shapes or closed composite shapes are allowed. For example, any lines or open 

polylines will not be allowed. 
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9 Modifying 3D models 

Once the 3D model is created, the next step is to modify the created models to create more 

complex 3D models and thereby achieve the desired output. This chapter will guide you 

through various modification features provided by ScanMaster™ Designer software. 

9.1 Viewing options 

The View group in the Home tab provides a rich set of view port-oriented operations. You 

can change the view of the 3D canvas according to your requirements to help you navigate 

to each location of the model and observe it in detail. 

 

Figure 28 – View group 

9.1.1 Zoom 

The Zoom commands are available in the Home > View section. Zoom commands are very 

useful when having to go back and forth between editing small details at a magnified level 

and for checking the overall picture at a minimized level. 

To Zoom In / Out 

1. Go to the Home > View group. 
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2. Click Zoom In /Zoom Out , or select a more exact zoom percentage in the 

Zoom Factor percentage menu. 

Zoom In increases the magnification level of a drawing on the canvas. 

Zoom Out reduces the magnification level of a drawing on the canvas. 

TIP 

You can also use the mouse wheel to increase or reduce the magnification level of the 

canvas. Hold the CTRL key pressed while using the mouse wheel for a finer step change of 

the magnification level. 

 

Zoom Window 

Zoom Window offers a quick way to view a certain area of the drawing. 

1. Click Zoom Window . 

2. Select a certain area of the drawing. 

Fit To All 

Fit to All allows resizing the drawing canvas width/height to display it in any screen size. 

• Click Fit to All . 

9.1.2 Pan 

Panning allows you to quickly move around the canvas at the same magnification you have 

currently set. 

1. Go to the Home > View group. 

2. Click Pan . 

3. Click on the drawing canvas and drag it away to the location you desire and release. 
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– OR – 

1. Hold the CTRL key and the middle mouse button pressed while dragging the cursor 

on the canvas. 

2. Release the mouse button when the drawing is at the position you desire. 

TIP 

The cursor image changes to a hand cursor when panning is activated. 

9.1.3 Show Field  

The Show Field command in the Home > View group resets the drawing canvas to the default 

viewing configurations. 

• Click on the Show Field  button to view the default viewing configurations of the 

drawing canvas. 

9.1.4 Rotate 

The Rotate function allows you to rotate the drawing canvas according to your requirements. 

• Click on the Rotate  button on the View group of the Home tab. 

– OR – 

Hold the middle mouse button pressed while dragging the cursor on the drawing 

canvas to rotate into the desired angle. 

9.2 Transformations 

Transformation options can be accessed in the Transformations group on the Modeling tab. 

This group provides basic transformation options including rotation, scaling, mirroring, 

moving to the origin, moving to a desired location and face-oriented aligning. 
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Figure 29 – Transformations group 

9.2.1 Rotate 

You can use the Rotate command to rotate the 3D model around a standard axis (X, Y, Z) or 

an arbitrary axis and the angle. 

To rotate a 3D model 

• Select the appropriate model and click on the Rotate command in the 

Transformations group. 

You can either specify the Standard Axis parameters or else specify the Arbitrary 

Axis parameters to rotate a 3D model. 

Standard axis 

1. To rotate a 3D model by specifying the standard axes select the desired axis 

and define an Angle to be rotated. 

2. Click OK to confirm. 
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Figure 30 – Rotate window – Standard Axis tab 

Arbitrary axis 

Rotation by an Arbitrary Axis can be done in two ways. You can either select to rotate 

by defining a Point and Vector or by defining Two Points on the 3D workspace. 

Point and Vector 

1. To rotate by a point and a vector select the Point and Vector option from 

the Arbitrary Axis tab. 

2. Define the point by specifying the X, Y and Z values. 

3. Define the direction vector by specifying the I, J and K values. 

4. Define the rotation Angle. 

5. Click OK. 
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Figure 31 – Rotate window – Arbitrary axis – Point and Vector 

Two Points 

You can rotate 3D models by defining two 3D points as shown in the figure below. 

1. Define the first point by specifying the X, Y and Z values. 

2. Define the second point by specifying the X2, Y2 and Z2 values. 

 

Figure 32 – Rotate window – Arbitrary axis – Two Points 

TIP 

Refer to subsection 11.2.2 on page 115 for more details on specifying the 

arbitrary axes. 
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9.2.2 Scale 

This function allows you to change the size of any 3D model on the canvas. 

To access the Scale command 

1. Click the Scale  button of the Transformations group. 

You will see the following Scale dialog box. 

 

Figure 33 – Scale window 

2. Define scale factors for X, Y and Z directions in the appropriate text boxes. 

3. Check the use same factors as in X check box to use the same scale factor given for 

the x direction for the other two directions also. 

4. Select the Base Point as required. 

The selected base point will be kept fixed while scaling. 

TIP 

The Scaling Factors should be greater than zero and if the value of the scale factor is 1 

then there will be no change to the size of the object. 
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9.2.3 Mirror 

This option will create a symmetrical mirror image of the selected 3D model according to the 

specified values in the Standard Axis or Arbitrary Axis tabs. You can access the Mirror  

command from the Transformations tab. 

1. Select the 3D model you want to mirror. 

2. Click the Mirror  command in the Transformations group. 

 

Figure 34 – Mirror window – Standard Axis tab 

3. Define the Standard Axis values on the Mirror dialog box or select the Arbitrary Axis 

tab to mirror with respect to an arbitrary axis. 

4. Select either Point Vector or Two Points options and define the respective values of 

the mirror axis. 

5. If you check Keep original object, the original 3D model will remain on the drawing 

canvas. 

9.2.4 Move 

This function allows you to move a 3D model relatively to a specified direction. The Move 

 command can be accessed in the Transformations group. 
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1. To move a 3D shape, select the 3D shape you want to move and click the Move 

command found in the Transformations group. 

 

Figure 35 – Move window 

2. The Delta X, Delta Y and Delta Z values represent the relative values of the move 

along the respective directions. 

3. Specify the Delta values of the X, Y and Z directions. 

4. Click OK to confirm. 

9.2.5 Move to Origin 

This command in the Transformations group allows you to the move the reference point of 

the 3D object to the origin. 



9 Modifying 3D models  9.2 Transformations 

ScanMaster Designer 3D Extensions, User Manual, 1040-0009 Rev D 67 

 

Figure 36 – Move to Origin 

9.2.6 Aligning 

This function allows you to align two or more objects by their bounding boxes according to 

any of the given alignments. 

You can access the Aligning command in the Transformations group on the Modeling tab. 

 

Figure 37 – Aligning 

To align the objects 

1. Select the desired 3D objects you want to align. 
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2. Click on the drop-down arrow of the Aligning command to view the available 

alignment options. 

3. Select a suitable alignment option from the Aligning list. 

The Center X Align function will align the center of the bounding boxes of the two 

selected shapes to the center X value of the first selected shape. 

 

A – BEFORE ALIGNING 

 

B – AFTER ALIGNING 

Figure 38 – Center X Align 

The Center Y Align function will align the center of the bounding boxes of the two 

selected shapes to the center Y value of the first selected shape. 

The Center Z Align function will align the center of the bounding boxes of the two 

selected shapes to the center Z value of the first selected shape. 

9.2.7 Face Oriented Alignment 

This function will change the orientation of the 3D shape in a way that the selected face will 

be turned to the specified direction. 



9 Modifying 3D models  9.3 Boolean Operations 

ScanMaster Designer 3D Extensions, User Manual, 1040-0009 Rev D 69 

To change the face-oriented alignment of a selected object 

1. Click the Face Oriented Alignment  command from the Transformations grouip. 

You will find the following window. 

 

Figure 39 – Orient Face window 

2. To change the face-oriented alignment you must first select the Faces command from 

the Selection Mode list in the Solid Operations group. 

3. Select the 3D shape which you want to change the face-oriented alignment. 

4. Select any of the face-oriented alignment options from the Face Oriented Alignment 

list. 

TIP 

For more details on Solid Operations group refer to section 9.4 on page 73. 

9.3 Boolean Operations 

Boolean Operations allows you to modify the 3D objects by cutting, fusing, and extracting 

common areas of the 3D objects. 
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Figure 40 – Boolean Operations group 

The following Boolean Operations were done by inserting a Cylinder with a Height of 25 and 

a Radius of 10 and a Sphere with a Radius of 10 and Center Z as 25. 

TIP 

When you perform any Boolean Operation, the original shapes will become a single 3D 

object. The Shape Tree will display it as one shape as shown in the figure below. 

 

Figure 41 – Compound shape on Shape Tree 

9.3.1 Cut 

The Cut  command gives you the option of cutting a particular overlapped section of the 

first selected 3D shape from the other selected 3D shape. 

You can access this command in the Boolean Operations group on the Modeling tab. 
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To cut an overlapped section of an object 

1. Place the 3D shapes such that one shape overlaps the other. 

2. Select the 3D shape that you want to modify. (Select the Cylinder) 

3. Select the other 3D shape that you use to cut. (Ctrl + click the object) 

4. After you have selected the two 3D shapes, click the Cut button in the Boolean 

Operations group. 

 

Figure 42 – Cut shape 

9.3.2 Fuse 

The Fuse  command gives you the option of joining two 3D objects together to make a 

single 3D shape. 

You can access the Fuse command in the Boolean Operations group on the Modeling tab. 

To fuse two 3D objects 

1. Select the two 3D objects you want to fuse. 

2. Click on the Fuse button in the Boolean Operations group. 
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Figure 43 – Fuse shape 

9.3.3 Common 

The Common  command gives you the option to extract the common section of two 

selected 3D shapes. 

You can access the Common command in the Boolean Operations group. 

To extract the common section using the Common operation 

1. Select the two 3D shapes. 

2. Click the Common button in the Boolean Operations group. 

TIP 

ScanMaster™ Designer software allows you to select only two shapes at a time to make a 

Boolean Operation. 
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Figure 44 – Extracting the common part of the two 3D shapes 

9.4 Solid Operations 

You can do certain modifications to the basic 3D models using the options in the Shape 

Operations group on the Modeling tab. 

 

Figure 45 – Solid Operations group 

TIP 

These functions will form compound shapes in the Shape Tree same as in Boolean Operations. 

9.4.1 Selection Mode 

This command in the Solid Operations group allows you to specify the selection mode. 
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Figure 46 – Selection Mode 

 

TIP 

Neutral mode is the default selection mode which enables the selection of whole 3D shapes. 

9.4.2 Face Revolve 

Face revolving function allows you to revolve a face of a 3D object over an axis. The revolving 

axis can be defined by specifying the values on the Standard Axis tab or on Arbitrary axis tab. 

To revolve a face of an object: 

1. Select the desired 3D object. 

2. To change the Selection Mode to Faces selection mode, click the Faces option from 

the Selection Mode  list in the Shape Operations group. 

3. Select the face you want to revolve. 

4. Click on the preferred face of the3D object. 

5. Click the Face Revolve  command in the Shape Operations group. 

You will find the Revolve dialog box as you see in the figure below. 
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Figure 47 – Face revolved by a standard axis 

6. Define the axis that you want to revolve on the Standard Axis tab or select the 

Arbitrary Axis to revolve with respect to an arbitrary axis. 

7. Select either Point and Vector or Two Points options and define the respective 

values of the revolving axis. 

8. Define the revolving angle in the Angle text box. 

9. Click OK. 

9.4.3 Face Extrusion 

This function allows you to change the dimensions of an object by extending a selected face 

according to a specified extrusion length. 

You can access the Face Extrusion  command in the Shape Operations group on the 

Modeling tab. 

To extrude a selected face of an object 

1. First change the Selection Mode to Faces selection mode, click the Faces option from 

the Selection Mode  list in the Shape Operations group. 

2. Select the face you want to extrude. 

3. Click the Face Extrusion button in the Shape Operations group. 



9 Modifying 3D models  9.4 Solid Operations 

ScanMaster Designer 3D Extensions, User Manual, 1040-0009 Rev D 76 

4. Click on the face of the object and specify the length to be extruded on the given text 

box as shown in the figure. 

 

Figure 48 – Define the extrusion length 

– OR – 

You can also click and drag the mouse pointer on the selected face until you reach 

the desired length that you need to extrude as you see in the next figure. Click on the 

canvas after you reach the desired length. 

 

Figure 49 – Drag to the desired extrusion length 
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9.4.4 Fillet 

This function allows you to modify the edges of a selected 3D object.   

To fillet a 3D object 

1. Change the Selection Mode according to your requirements. 

2. Select the 3D object on which you want to perform the filleting operation. 

3. Click the Fillet command. 

4. Specify the fillet Radius on the Fillet dialog box. 

 

Figure 50 – Fillet window 

 

Figure 51 – Fillets on different selection modes 

The above figure shows how a Box with the dimensions of 12, 12, 12 will be modified 

according to its different selection modes when the Fillet command was used with a Radius 

of 5. 
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TIP 

The Fillet function will not be applicable to the Vertices selection mode. 

9.4.5 Lighting 

The Lighting command allows you to change the lighting effects of the 3D object on the 3D 

drawing canvas. 

• Click on the Lighting button in the View group of the Home tab. 

The following window will be displayed. 

 

Figure 52 – Lighting window 

Ambient Light 

Ambient Light  effect illuminates uniform light rays around the object from 

every direction. 
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Figure 53 – Illustration of Ambient Light 

 

Figure 54 – Ambient Light 

TIP 

You can select any color of the light from the Color option in the Parameters 

group. 

Directional Light 

Directional Light  emits light rays from a particular defined direction. 

 

Figure 55 – Illustration of Directional Light 
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Figure 56 – Directional Light 

Spot Light 

The Spot Light   effect spots the light ray on to a particular specified 

position on the canvas. 

 

Figure 57 – Spotlight 

Target specifies the targeting position. 

Position specifies the position of the light. 

Point Light 

The Point Light   command enables you to spread light rays towards the 

drawing canvas from a specified position of the light. 
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Figure 58 – Illustration of Point Light 

 

Figure 59 – Point Light 

9.4.6 Deleting the light effects 

To delete any inserted light effect on the drawing canvas 

1. Select the light effect you want to delete from the Lighting window. 

2. Click on the Delete Light  button. 

TIP 

Select the Keep default light on check box on the bottom-left of the window to reset the light 

effects to the default settings. 
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10 Process preparation 

The final step before you mark your 3D model is the preparation of the 3D process. This 

chapter guides you on the process of preparing the 3D model for your laser marking.   

10.1 Surface Marking process 

After you have created the 2D and 3D models you can start working on your 3D marking 

process. In the ScanMaster™ Designer software the surface marking options are designed to 

mark 2D models on a non-uniform 3D surface. This software enables you to project or wrap a 

2D model on to the 3D model. 

TIP 

Refer to section 11.1 on page 112 for more details about the differences between the 

Projection and Wrapping features in 3D surface marking. 

To start a Surface Marking process 

1. Select the 3D model from the Project Explorer which you want to process. 

2. Click on the Surface Marking  button in the Marking Process group of the 

Project tab. 

 

Figure 60 – Surface Marking 
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You will find the new surface marking process element on the Project Explorer once 

you create a surface marking process. 

 

Figure 61 – Surface marking process 

3. If you click on the Surface Marking button before selecting the 3D model you will 

find the following Properties tab which will direct you to select the desired 3D model. 

 

Figure 62 – SurfaceMarking Properties tab 

The Properties tab allows you to select the appropriate 3D model from the given 3D 

Model List. 
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4. Click on the 3D Model List drop-down arrow to select the 3D model you want to 

process. 

5. Move to the Model tab to proceed. 

Then you will see the surface marking 3D model that you selected. 

Adding a 2D Image 

To add the 2D image to the 3D model on the surface marking process 

1. Click on the Add 2D Image  button in the Surface Marking group of the 

SurfaceMarking tab. 

 

Figure 63 – Add 2D Image button 

You will find the following Add 2D Image dialog box. 

 

Figure 64 – Add 2D Image 

2. Select the appropriate 2D model from the 2D Image drop-down list. 

3. Select the method, either Projection or Wrapping, you want to map the 2D model 

from the Surface Marking Method drop-down list and click OK to confirm and 

proceed. 
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10.2 Modify 3D surface marking model 

10.2.1 Placement of 2D image 

You can apply transformations to the 2D image before you do the marking to obtain the 

correct position and scaling of the 2D image. ScanMaster™ Designer software allows you to 

Move, Scale and Rotate the 2D model to adjust and fix it to the 3D model according to your 

requirements. 

1. Click on the Shape Tree tab. 

2. Select the desired 2D model. 

You will be able to find the Properties panel in the right-bottom of the window. 

 

Figure 65 – Properties of 2D Image 
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Moving 2D Images 

You can use the options in the Move section of the Properties panel to move the 2D image 

into the desired place. 

The arrows as shown in the figure above, allow you to move the 2D image along the X and Y 

directions of the 2D image. 

You can use the Move 2D Image  command to move the 2D. Click and drag the mouse 

on the 2D image. Move 2D Image command functions only before you apply the 2D image 

to your 3D model. 

TIP 

The number of units in which the 2D image moves at each click of the arrows will be as 

configured in the Moving Step option in the Miscellaneous 3D page of the Application 

Preferences wizard. 

Scaling 2D Images 

You can use the options in the Scale section of the Properties panel to scale the 2D image 

according to your requirements. 

The arrows  shown in the figure of the Properties tab in the previous page allow you to scale 

the 2D image along the X and Y directions of the 2D image. 

The options in the Base Point group allow you to select a desired base point.  The selected 

base point will be kept fixed while you scale the 2D image. 

Check the Maintain Aspect Ratio option to keep the X and Y scale factors both similar. 

TIP 

The number of units in which the 2D image scales at each click of the arrows will be as 

configured in the Scaling Percentage option in the Miscellaneous 3D page of the Application 

Preferences wizard. 
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Rotating 2D Images 

You can use the options in the Rotation section of the Properties panel to rotate the 2D 

image to the desired angle.  

Specify the angle to be rotated on the Angle text box and select the desired anchor point 

from the Anchor Point group. The object will be rotated around the selected anchor point. 

You can use the Rotate clockwise and Rotate Anticlockwise buttons to rotate to the 2D 

image in the desired direction. 

10.2.2 Viewing surface marking objects 

ScanMaster™ Designer software provides you various viewing options of the surface marking 

objects. 

You can find these options in the View group on the SurfaceMarking tab. 

 

Figure 66 – Viewing surface marking objects 

Shape And Mapped Image  

The Shape and Mapped Image  function allows you to view the 3D model and the 

mapped 2D image both on the drawing canvas. 

You will find this viewing option by default in a surface marking process. 
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Figure 67 – Shape and Mapped Image 

Bounding Box and Shape 

The Bounding Box and Shape  function allows you to view the bounding box of the 

mapped 2D image along with the 3D model. 

This feature efficiently adjusts a 2D image especially when you handle complex models. 

 

Figure 68 – Shape and Bounding Box 

Mapped Image Only 

The Mapped Image Only  function allows you to view only the mapped image on the 

drawing canvas. 
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Figure 69 – Mapped Image Only 

10.2.3 Running the surface marking project 

Once the surface marking process is configured you can proceed to laser marking. The 

ScanMaster™ Designer provides a very flexible way of managing and controlling the laser 

marking processes through the script object of the project. 

By default, the script will contain a single command to laser mark all the objects in the project 

tree. To run only the surface marking process, simply delete the default “ScanAll()” command 

and insert <ScriptVariableName>.Start() command to the script. The command starts with 

the surface marking object name and followed by a “.Start()” command.  For example, to start 

“SurfaceMarking1” object simply insert SurfaceMarking1.Start() command to the script. 

10.3 Engraving process 

Engraving is the process of implementing any desired 3D model by removing material from a 

3D object. The process of engraving in ScanMaster™ Designer software enables you to do a 

laser engraving project. 
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10.3.1 Create an engraving process 

To create an engraving 

1. Click the Engraving command in the Marking Process group on the Project tab. 

 

Figure 70 – Add engraving model in wizard 
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2. Click the Associated 3D Model list drop-down arrow to select the 3D model that you 

want to perform the engraving. 

3. Specify the settings of the sections and hatching styles of the engraving process. 

 

Figure 71 – Sectioning options 

The Sections group refers to a collection of layers in the engraving 3D model. Initially the 3D 

model is in a single section. You can split the 3D model into different sections if required. 

Dividing the 3D model into different sections is useful when there are variations in the 

properties of the materials, across the cross-section of the 3D model. 

The number of layers in a section affects the quality of the output. The number of layers in a 

section depends on the materials. The harder the material, higher the number of layers 

should be. 

You can specify the properties of the section(s) from the Sectioning options wizard. 

To add a new Section 

• Click on the Add Section  button in the Sections group. 

To change the properties of the Section 

1. Specify the Minimum Z value of the section. 

The Minimum Z and Maximum Z values define the total Z range of the section by 

specifying the top-most and bottom-most values. 
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2. Select either Number of Layers or Layer Gap to specify the number of layers in 

which the engraving will be processed. 

3. Select a Color for different sections so that you can identify the difference of the 

applied sections. 

4. Click the Delete Section  button to delete any sections from the process. 

5. Add a hatching style from the given Hatch styles in the Hatching group. 

6. Specify the properties of the Hatching styles. 

7. Click the Delete Hatch  button to delete a Hatch. 

8. Click Finish. 

TIP 

Refer the ScanMaster™ Designer 2D User Manual, Hatch Operations in chapter 8 Shape 

Operations, for more details on specifying the Hatching Styles. 

 

Figure 72 – Sections and Layers of engraving 

10.3.2 Modify an engraving 

From the Properties tab engraving properties can be changed even after creating the 

Engraving process. The changes made through the Properties tab will be added while 

navigating back to Engraving View. 
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Figure 73 – Engraving Properties 

10.3.3 Modify a Section 

You can also change the properties of the hatching styles and the colors of the sections. 

1. Select the section(s) from the Engraved Layers tab. 
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Figure 74 – Engraved Layers tree 

2. Edit the properties of the section from the options in the Properties panel below the 

Engraved Layers. 

 

Figure 75 – Section Properties 

3. Click on the Update Engraving button to confirm the changes. 
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10.3.4 Viewing engraved objects 

The options in the Viewing Engraved Objects group on the Processed Model tab are featured 

in a way that enables you to view the engraved objects in three different styles. 

The Boundary Only  function allows you to view only the boundary of the engraving 

sections  

The Hatch Only  function allows you to view only the hatch applied to the 3D shape. 

The Boundary and Hatch  function allows you to view both the boundary and the hatch 

of the 3D shape which is to be engraved. 

 
Boundary Only Hatch Only Boundary and Hatch 

Figure 76 – Viewing boundary and hatch of engraved objects 

10.3.5 Engraving Simulations 

After you have specified the sections of your engraving process you can preview the 

engraving process using the options in the Engraving Simulations group on the Processed 

Model tab. 
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Figure 77 – Engraving Simulations group 

1. Select the desired section(s) from the Engraved Layers tab. 

2. Click on the Start  button to see the order of the engraving process. 

3. Click the Stop  to stop the simulation. 

The simulation will depend on your selection of the section(s) from the Engraved layers tab. 

If you want to preview the whole 3D model engraving process, select the engraving process 

from the Engraved Layers tab or select the desired section only to view the simulation of that 

section only. 

10.3.6 Running the engraving project 

Once the engraving process is configured you can proceed to laser marking. The 

ScanMaster™ Designer provides a very flexible way of managing and controlling the laser 

marking processes through the script object of the project. 

By default, the script will contain a single command to laser mark all the objects in the project 

tree. To run only the engraving process, simply delete the default “ScanAll()” command and 

insert <ScriptVariableName>.Start() command to the script. The command starts with the 

engraving object name and followed by a “.Start()” command.  For example, to start 

“Engraving1” object simply insert Engraving1.Start() command to the script. 

10.4 Sample Surface Marking 

In this section you will be provided an example considering a simple scenario in 3D surface 

marking process. 
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Scenario: Create a model of a pipe, project and wrap a text ScanMaster to the internal surface 

of the pipe. 

To try this sample you need to 

1. Start ScanMaster™ Designer. 

2. Create the 3D Model. 

3. Modify the 3D Model. 

4. Transform the 3D Model. 

5. Create the 2D Model. 

6. Change the Viewing Orientation. 

7. Process. 

8. Edit the 2D Model. 

10.4.1 Starting ScanMaster™ Designer 

1. Click Start > Programs > CTI > ScanMaster™ Designer. 

2. Click New > New 3D Project. 

10.4.2 Create the 3D model  

1. To insert a cylinder shape to the drawing canvas, click on the Cylinder command 

in the Primitives group on the Modeling tab. 

2. Specify the Radius and Height of the cylinder. 

3. Click OK. 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Completed%20Manuals/ScanMaster™_Designer_1#_Starting_
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Figure 78 – Cylinder on the canvas 

4. To insert a box shape, click on the Box  command in the Primitives group on the 

Modeling tab. 

5. Specify the Base Point, Width, Height, and Length of the Box. 

6. Click OK. 

 

Figure 79 – Cylinder and Box shape on the canvas 
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10.4.3 Modify the 3D model  

1. Select both shapes. 

TIP 

Select the Cylinder shape initially and then select the Box shape as you are about to 

cut the Cylinder using the Box shape. 

2. Click Cut  in the Boolean Operations group on the Modeling tab. 

 

Figure 80 – Cylinder shape cut in half on the canvas 

3. Insert another Cylinder  shape. 

4. Specify the Radius and Height of the Cylinder. 

5. Click OK. 
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Figure 81 – Half Cylinder and Cylinder shape on the canvas 

6. Select both shapes. 

7. Click Cut  in the Boolean Operations group on the Modeling tab. 

The result will be as shown in the figure below. 

 

Figure 82 – Half Cylinder cut to half pipe shape on the canvas 

10.4.4 Transform the 3D model 

Rotate 

1. Select the 3D model. 

2. Click on the Rotate option in the Transformations group on the Modeling tab. 
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3. Specify the Standard Axis and the Angle to be rotated. 

 

Figure 83 – Rotating parameters 

Move to Origin 

1. Click the Move to Origin  button in the Transformations group. 

2. Select the Center of Bottom option from the list. 

10.4.5 Create the 2D image  

1. Click the 2D image that is already added to the project by default. 

2. Click the Insert Text button. 
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Figure 84 – Text editor 

3. Specify the Text Height and press Enter. 

4. Type ScanMaster as the text. 

5. Click OK. 

 

Figure 85 – 2D image 
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10.4.6 Change the viewing orientation 

Before you start the process change the viewing orientation to Top to make your work much 

easier. 

1. Click View Orientation button in the View group. 

2. Select Top from the View Orientation list. 

 

Figure 86 – Top orientation 

10.4.7 Process 

To do a Projection 

1. Click the Surface Marking  button in the Process group on the Home tab. 

2. Select the Surface Marking1 process from the Project Explorer tab. 

3. Click the Add 2D Image  button in the Surface Marking group on the Processed 

Model tab. 
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Figure 87 – Add 2D Image 

4. Select the 2D Model 1. 

5. Select Projection from the Surface Marking Method drop-down menu. 

6. Click OK. 

10.4.8 Edit the 2D image 

1. Select the Shape Tree tab. 

2. Select the 2D Model 1. 

3. Select the Properties tab of the Shape Tree. 

4. Check the Maintain Aspect Ratio check box. 

5. Scale down the 2D image across the X axis to adjust according to the 3D model. 

6. Click on the Apply  button to project the 2D image to the 3D model. 
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Figure 88 – Apply Projection 

To do a Wrapping 

1. Click Add 2D Image  button in the Surface Marking group on the Processed 

Model tab. 

2. Select the 2D Model 1. 

3. Select Wrapping from the Surface Marking Method drop-down menu. 

4. Select the desired face of the 3D model where you need to wrap the 2D image. 

 

Figure 89 – Select the desired face 

5. Click Ok. 
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6. Adjust using the Scale and Move functions in the Properties panel. 

7. Click Apply   button to wrap the 2D image to the 3D model. 

 

Figure 90 – Projection and Wrapping 

10.5 Sample engraving 

In this section you will find a sample engraving process performed using ScanMaster™ 

Designer software. The expected output of this sample scenario is to create a physical logo 

using a work piece of two metals including aluminum and brass. 
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Figure 91 – Predesigned engraving model 

Assume that you have a cylindrical work piece with a combination of two metal layers as 

aluminum and brass. To create this physical logo, you need to remove the unnecessary 

sections by engraving. 

For you to get this output you must create an appropriate mold that tells the system which 

parts to be engraved and which parts are not to be engraved. The mold should consist only 

the sections that needs to be engraved. A predesigned 3D model which looks exactly as the 

actual output will be required to extract some sections from the mold which are not 

supposed to be engraved. 

The ultimate result of this process should remain a “S” shape on the aluminum layers and 

make two screw holes in the brass layer. 

Refer the following sections to check how this sample engraving can be performed using 

ScanMaster Designer 3D Extension. 

To try this sample, you need to 

1. Open ScanMaster™ Designer 3D project. 

2. Create the mold. 
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3. Modify the model. 

4. Prepare the engraving process. 

5. Check the engraving simulation. 

10.5.1 Open ScanMaster™ Designer 3D project 

1. Click Start > Programs > CTI > ScanMaster™ Designer 

2. Click New. 

TIP 

Check section 7.1 on page 46 to revise the facts that you should keep in mind when handling 

a 3D project using ScanMaster™ Designer. 

10.5.2 Create the mold  

The aim of creating this mold is to extract an appropriate virtual model that allows you to 

engrave the desired structure on the original material. 

Import the predesigned 3D model 

1. Go to Project Ribbon tab. 

2. Select 3D model   button from the Import  drop down button. 

  

Figure 92 – Imported 3D model 
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3. Click the Move to Origin > Center of Bottom option on the Transformations panel if 

required. 

To insert a cylinder 

1. Insert a Cylinder from the Basic group on the Home tab. 

2. Define the Radius and Height as 12.6 and 5. 

  

Figure 93 – Inserted Cylinder 

10.5.3 Modify the mold 

Make sure that you have moved both the models to the origin of the drawing canvas. 

TIP 

The cylinder shape is inserted to the origin of the drawing canvas by default and the 

imported model should be moved to the origin. Both models will be place in the same 

position of the canvas to perform the Boolean Operation. 

 

1. Select the two models. First select the Cylinder and then the imported 3D model. 

2. Click Cut command in the Boolean Operations group on the Modeling tab. 

The figure below shows the mold that was created. 



10 Process preparation  10.5 Sample engraving 

ScanMaster Designer 3D Extensions, User Manual, 1040-0009 Rev D 110 

 
Isometric view Right view Top view 

Figure 94 – Modified image in different view orientations 

10.5.4 Prepare for the engraving process 

The next step in this scenario is to prepare the model for the engraving process. 

1. Click the Engraving  command in the Marking Process group on the Project tab. 

 

Figure 95 – Specifications of Section 1 
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2. Specify the Minimum Z of Section 1 as 2.4. 

TIP 

The height of the sections depends on the heights of the two materials. Measure the 

height of the original materials and specify the heights of the sections respectively. 

 

3. Define appropriate number of layers to each section depending on the materials of 

the sections. 

4. Insert a desired type of hatch for both sections from the given hatching styles. 

5. Click Finish. 

 
Right view Isometric view 

Figure 96 – Engraving Layers and Sections of the 3D model 

10.5.5 Check the engraving simulation 

After you specified the parameters for your engraving process you can use the Engraving 

Simulation commands to view the simulation and adjust if needed. 

1. Click Start command of the Processed Model > Engraving Simulation panel to 

view the engraving simulation. 

2. Click Stop command to stop the simulation. 
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11 Appendix 

11.1 Surface Marking 

Surface marking is one of the available 3D scanning processes. Surface Marking in 3D 

scanning projects refers to mapping a 2D image to a 3D surface there by obtaining a quality 

3D marking. ScanMaster™ Designer provides you features that enable you to do surface 

markings in two different styles: 

• Projection 

• Wrapping 

Multiple 2D images can be projected or wrapped to a 3D model in different viewpoints 

according to the users requirements. 

11.1.1 Projection 

Projection is used to project a 2D image to a 3D surface. Projection in 3D surface marking 

refers to mapping a 2D image to a 3D surface in a way that the resulting 3D image will be 

undistorted when viewing in the direction of the projection. If you view the projected image 

in a different direction, you will see that the edges of the image have extended beyond the 

border or line. 
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Figure 97 – Projection 

11.1.2 Wrapping 

This technology is used to wrap a 2D image to a 3D surface. Wrapping in 3D surface marking 

refers to mapping a 2D image in a way that the resulting image will have the minimum 

distortion locally when viewed in any direction. 
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Figure 98 – Wrapping 

11.2 Specifying the axes 

Most of the functions in ScanMaster™ Designer allow you to select the Standard Axis or the 

Arbitrary Axis. This section will help you to understand the difference between the standard 

axes and the arbitrary axes. 

11.2.1 Standard Axis 

The standard axes are defined by the X, Y and Z values as you see in the figure below. These 

axes refer to the normal axes to define the position on the drawing canvas. 
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Figure 99 – Standard Axis 

11.2.2 Arbitrary Axis 

To define the Arbitrary Axis, you can specify in two ways. You specify either the Point and 

Vector or the Two Points. 

Point and Vector can be used in situations where you want to specify a position and the 

vector or the direction from that point onwards. 
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Figure 100 – Arbitrary Axis – Point and Vector 

Two Points can be used in situations where you want to specify two points to define a 

direction across the defined two points which includes the starting points and the end points 

on the drawing canvas. 

 

Figure 101 - Arbitrary Axis - Two Points 
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